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Overview

PT Tracker is designed for use by Precision Teaching practitioners. It can track the progress of
multiple students and can track each student's progress in one or more skills. The program tracks
and displays timings over a period of up to 210 consecutive days. If more than 210 days are
needed for a particular skill, you’ll need to start a new skill for the student.

PT Tracker stores all the data for a given student in one file. Every time any data is changed for
a student, the entire file is automatically saved. The following information is saved in a student
file:

e First name

e Last name

o ID: The ID field is optional, and the user can decide its use and meaning. For example, it
could be used to distinguish two students with the same name, or two different files for
the same student.

o SKill(s): Each skill has its own name that you provide. You can also specify: the time
units for measurements (minutes, hours, days); the range of the y-axis; the number of
days of data to collect (up to 210); and other parameters.

« Timing(s): Each timing is associated with a skill and contains the timing date, duration,
count and the number of errors.

« Annotation(s): Each skill can have zero or more annotations (phase changes, celeration
lines, aim stars) associated with it.

o Default skill: This identifies the skill displayed when you load the data for a student.

The data for a student is stored in a file with this file naming convention:
FirstName LastName ID.ptt

For example, the data for student Jane Doe, whose ID is 23", will be stored in a file named
Jane Doe 23.ptt. The data for student John Doe, who hasn't been assigned an 1D, will be

stored in a file called John Doe .ptt.

Annotations (phase changes, celeration lines, and aim stars) were added in version 5.0 of PT
Tracker. As with timings, annotations are stored in the student file with the associated skill.
Whenever an annotation is added, modified, or deleted, the student file is automatically updated.
There is no need to save the file (in fact, there is no manual way to do so!).



Menus

Some menu options can be accessed via keyboard shortcuts. On PC’s, you hold down the Ctrl
key and then press the specified letter. On Macs, you hold down the Cmd key and then the letter.
The keyboard actions are:

e Citrl-L: File / Load student

e Ctrl-S: File / Select skill

e Ctrl-T: File / Edit timings

e Ctrl-P: Chart / Phase change
e Ctrl-C: Chart / Celeration line
e Ctrl-A: Chart / Aim star

File Menu
The following selections are available from the File menu:

o Load student: Presents a file selection window so that you can choose a student file to
load into PT Tracker.

e New student: Displays the New Student screen to add a new student to the system (this
will create a file for the new student).

o Select skill: Changes the currently active skill.

e New skill: Displays the New/Edit Skill screen to add a new skill to the currently loaded
student.

o Edit skill: Displays the New/Edit Skill screen so that you can change the skill parameters
(such as the skill name, the range of the y-axis, the number of days on the chart, etc.).

o Set default skill: Allows you to choose a default skill from the current student's skill
list. The default skill will get displayed whenever a student's data is loaded into the
program. It will also be the pre-selected skill when you choose the Select skill option
(above).

« Edit timings: Displays the Edit Timings screen, which displays all the timings for the
currently selected skill. Allows you to add timings to the list, including for previous
days. Also allows you to delete and modify timings from the list.

Chart Menu

The Chart menu lets you add new annotations to the chart, including phase changes, celeration
lines and aim stars. You can also edit and delete annotations you have already added. The menu
items on the Chart menu are:

e Phase change: Displays the New Phase Change screen for adding a new phase change.

e Celeration line: Displays the New Celeration Line screen for adding a new celeration
line.

e Aim star: Displays the New Aim Star screen for adding a new aim star.

e Edit annotations: Displays the Edit Annotations screen, which displays a list of
annotations and lets you view, edit or delete specific annotations.




Google Menu

The Google menu is only displayed when Google mode was activated at startup of PT
Tracker. See the section Google Mode for information about the Google menu.

Settings Menu

When you change a setting via the Settings menu, PT Tracker automatically rewrites the settings
file so that the updated setting will be the default the next time you start PT Tracker. The menu
items on the Settings menu are:

o Change/save default database directory: Establishes a new directory for saving student
files.

o Change skill defaults: Brings up the New/Edit Skill screen so that you can edit/modify
the defaults that are displayed whenever you make a new skill.

e Use SCC aspect ratio: If this menu item is checked, PT Tracker will use the Standard
Celeration Chart aspect ratio on all charts. The SCC aspect ratio causes the x2 celeration
line to have a 33-degree angle with respect to the horizontal axis.

e Save current chart size: Use this option after resizing your chart to make it the new size
the default size.

« Logo options: Brings up the Edit Logo Display screen, which allows you to disable the
logo or choose your own logo for displaying in the middle of the chart.

« Change nomenclature: Brings up the Change Nomenclature screen. Throughout this
documentation and also in the program menus, error messages and dialog boxes, two key
words are used: "student™” and "skill". If those words aren't appropriate for your situation,
you can choose this menu option to select different words to use. For example, you
might prefer to use the word "client™ instead of "student”. Note that, to change the word
"Skill" that appears in the chart title, you need to change the "Chart Title" field in the
New/Edit Skill screen.

o Change Google Drive folder: By default, student files are not saved to Google
Drive. However, if you specify a Google Drive folder using this menu option, then the
next time you start PT Tracker, it will attempt to save student files both to the local
computer and to the Google Drive folder you specify. Refer to the Google mode section
for more information about automatically saving student files to Google Drive.

« Chart appearance: Brings up the Chart Appearance screen, which allows you to change
the color and shape of some of the items that are displayed on the chart.

« Change output directory: Establishes a different directory into which PT Tracker output
files will be written. As of Version 5.1, the only output files are image files generated via
the Save chart as .png option of the Tools menu.

Tools Menu
The Tools menu has these options:
e Save chart as .png: Saves the current chart to a .png file in the output directory.

e Reset window size: Resets the size of the PT Tracker main window to its original size as
of when the program started up.



e Remove extra window space: When you resize the program in "SCC aspect ratio™
mode, typically there will be extra space in PT Tracker's main window. You can remove
the extra space using this menu option.

o Celeration line diagnostics: Displays a list of all the celeration lines in the current skill.
After you choose one, the Celeration Line Diagnostics screen will be displayed. That
screen displays many of the intermediate and final results of the celeration line
calculation.

« Display log: Displays a list of messages that may help the programmer diagnose
problems with PT Tracker. After there are 100 messages in the log, older messages are
deleted as newer messages are added. The log is erased when the program terminates.

Pop-up Menu

If you right-click on the chart on the main screen, a one-option menu will appear giving you the
option to save the chart to a .png file.



Screens
In all the screens described below, except the Main screen, the Escape key on the keyboard
performs the same action as the Cancel button. That is, it exits the screen without saving any
pending changes.

Main Screen
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The main screen provides a graphical display of the timings and annotations that you enter. The
two top corners of the chart have the start year and end year of the current skill.

On the main screen, you can add timings for the current date and skill. Just fill in these three
fields:

e Duration: The duration of the timing. When you first add a new skill for a student, you
will specify whether timings are in minutes, hours, or one day. The duration is in
whatever units were specified.

o Minute timings: Minute timings can always be specified as a decimal number.
For example, a minute and 15 seconds can be entered as 1.25. For minute timings
that are less than one hour, you can also enter them as MM:SS. For example,

1:15.



o Hour timings: Duration is specified as HH or HH:MM. For example, ten hours
can be entered as “10” or “10:00”. Ten hours and 22 minutes would be entered as
10:22.

o Day timings: “1” is the only allowable value for duration.

o Count: The number of times the student correctly performed the requisite task during the
specified duration.

e NumErrors: The number of errors made by the student during the timing.

After filling in those fields, add the new timing to the current skill by either pressing the Enter
key on the keyboard or clicking the Add Timing button on the main screen.

On the semi-log chart, timings are displayed this way:

o Duration: Duration is displayed as a black, horizontal line at 1/Duration. For example,
if the duration is five minutes, there will be a horizontal line at 0.2. This value is called
the “record floor.”

e Count: Count is converted to count per time unit. It will appear as a green-filled circle
calculated at Count/Duration. For example, if duration is two minutes and count is 182,
there will be a green-filled circle at 91. If count is 0 (a “no-count”), it is displayed as a
question mark just under the record floor line.

e NumErrors: NumErrors is converted to errors per time unit. It will appear as a yellow-
filled rectangle at NumErrors/Duration. For example, if duration is a half-minute and
there are 2 errors, there will be a yellow rectangle at 4. If NumErrors is zero, it is not
displayed.

You can change the default colors of the record floor, count per time unit, errors per time unit,

and no-count marks using the Chart appearance option of the Settings menu. You can also
change the shape of the count per time unit and errors per time unit marks using that option.

New Student Screen

& New Student X

First Name:
Last Name:

ID (optional):

Save Cancel

The New Student screen contains three fields:

e First Name: Required field.
e Last Name: Required field.



o ID: Optional field. The user can decide its meaning. For example, it could be used to
distinguish two students with the same name, or two different files for the same student.

When you click Save on the New Student screen, you will immediately be prompted to create a

skill for the new student. After that, the new student's data will be automatically written to that
student's file even if you click Cancel on the New Skill screen.

New/Edit Skill Screen

New Skill X
Skill Name: |
Timing Units: ?Minutes VVV Max Duration: 30.0
Y-Axis Min: 30.1 ‘ Vrl Y-Axis Max: 1,000 ij
Days in Chart: (105 Chart Title: SKill:

Save Cancel

The New/Edit Skill screen has these three uses:

e Add a new skill for the currently loaded student (via the File Menu New Skill option).

e Edit the currently selected skill of the currently loaded student (via the File Menu Edit
Skill option).

e Edit the skill defaults that appear whenever a new skill is created (via the Settings Menu
Change skill defaults option).

The New/Edit Skill screen has these three fields:

e Skill name: An identifier for the skill.

e Timing Units: Can be minutes, hours or days. (But the only allowable timing duration
for "days" is 1 day.) You can't change Timing Units after timings have been added to the
skill.

e Max Duration: This field is for error checking your timings. PT Tracker will not allow
you to enter a timing with a duration greater than Max Duration. The format depends on
what was specified for Timing Units, as follows:

o Minutes: A decimal number. For example, 40.5. Max Durations that are under
on hour can also be entered as MM:SS. For example, 40:30.

o Hours: Either HH or HH:MM

o Days: Always 1

e Y-Axis Min: The lowest value on the y-axis.

e Y-Axis Max: The highest value on the y-axis.

e Days in Chart: The number of days displayed on the chart. You can choose a number
from 70 to 210. It must be a multiple of 7.

e Chart Title: This description will appear before the skill name on the chart. If you leave
this field blank, the skill name will simply be displayed in parentheses.



When editing a skill:

= You cannot decrease Max Duration if some of the existing timings exceed the new
duration.

= You can't increase Y-Axis Min if there is currently viewable data that would no longer be
displayed on the chart with the new Y-Axis Min.

» You can't decrease Y-Axis Max if there is currently viewable data that would no longer
be displayed on the chart with the new Y-Axis Max.

= You can't decrease Days in Chart if there is currently viewable data that would no longer
be displayed on the chart with the new value of Days in Chart.

Edit Timings Screen

Edit Timings X
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Skill: Math Facts
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Right-click to display menu to view, edit or delete a timing.

The Edit Timings screen has three purposes:

o Display all timings for the current skill.
e Add new timings for the current or a prior date.
o Delete or modify timings.

To add a timing on the Edit Timings screen, just fill in the four fields (Date, Duration, Count and
NumErrors) and press the Enter key or click the Add Timing button. The Duration field will be
labeled Minutes, Hours or Days, depending on what was chosen for the Timing Unit when you
set up the skill.

To delete or modify a timing on the Edit Timings screen, right-click on the timing you want to
delete or modify. This will display the following menu:

e View: Displays the timing, along with the day number, count per time unit, errors per
time unit, and record floor.



e Edit: Displays the Edit or Delete Timing screen
e Delete: Prompts you to confirm and deletes the timing if you confirm.
e EXxit: Exits the Edit Timings screen.

You can double-click on the timing you want to delete or modify and the Edit or Delete Timing
screen will be displayed.

A time stamp is associated with every timing. The time stamp is always chosen automatically by
the PT Tracker program; it is not possible for the user to choose it. It is always set to the time of
day at which the timing was added to PT Tracker, which is not necessarily the time of day at
which the timing was performed. If you use the Edit or Delete Timing screen to modify the date
of a timing, its time stamp will be changed to the time at which the modification was performed.

Every timing also has an associated day number (DayNo). The day number is also determined

automatically by PT Tracker. Day zero, which is never used, is always the Sunday before the
first timing or annotation (i.e., phase change, celeration line, or aim star).

Edit or Delete Timing Screen

Edit or Delete Timing X
Date Minutes Count NumErrors
9/15/21| 0.5 15 1

| save Timing \ Delete Timing ‘ Cancel I

The Edit or Delete Timing screen displays these fields of the selected timing so that you can edit
them.

o Date: The date the timing was done. Format: MM/DD/YY or MM/DD/YYYY

e Duration: In the same units specified in the Timing Units field of the New/Edit Skill
screen. Cannot be greater than the Max Duration specified for its skill.

o Count: A number greater than or equal to 0. If Count is zero, it won't be displayed on the
chart.

e NumErrors: A number greater than or equal to 0. If NumErrors is zero, it won't be
displayed on the chart.

The Edit or Delete Timing screen has three buttons:

e Save Timing: Saves the changes made to the timing.

e Delete Timing: Deletes the timing.

e Cancel: Returns to the Edit Timings screen without changing the timing. The Cancel
button is the default, so if you just click Enter on the keyboard, you'll cancel the Edit or
Delete Timing screen without either saving or deleting the timing.



New/Edit Phase Change Screen

You display the New Phase Change screen via the Phase change option on the Chart menu.
You display the Edit Phase Change screen via the Edit Annotations screen.

Edit Phase

Comment:
Date:
Xd:

Save

Change

Less frequent practice

10/24/21
0.001

Y2: [990

X

Cancel

The New/Edit Phase Change screen lets you create or edit a phase change annotation on the
chart. A phase change appears, on a particular date, as a vertical line with a comment at the top
of the line. The line can start and end at the y-values you specify. The fields are:

Comment: The text that appears at the top of the phase change line.

Date: The date on which the phase change line will appear. Format: mm/dd/yy
Y1: The lowest y-value of the line.
Y2: The highest y-value of the line.

By default, the phase change line is red, but you can change its color using the Chart appearance

option of the Settings menu.

New/Edit Celeration Line Screen

You display the New Celeration Line screen via the Celeration Line option on the Chart menu.
You display the Edit Celeration Line screen via the Edit Annotations screen.

Start Date:

Label Placement:

Edit Celeration Line

9/1/21

Projection Date: |10/20/21

Use observations between these start and end dates:

End Date:

(Extend line to this date.)

@® pefault O User point

X

10/10/21

Which Data: Count e
Calc Method: Theil-Sen A
Save

’~ Cancel '

The New/Edit Celeration Line screen lets you create or modify a celeration line annotation on the
chart. A celeration line appears on the chart as a solid line that represents a student’s progress



over multiple timings. You can also specify the display of a dashed line representing a
projection of the celeration line into the future.

Every celeration line has a text label that identifies the celeration and the method used to
calculate it. The calculation methods are abbreviated as follows:

Th-Se: Theil-Sen

Reg: OLS regression
Sp-Mid: Split-Middle
Qtr-Int: Quarter-Intersect

The fields of the New/Edit Celeration Line screen are:

Start Date: The celeration line will be calculated using timings that appear on or after
this date. Format: mm/dd/yy

End Date: The celeration will be calculated using timings that appear on or before this
date. Format: mm/dd/yy

Projection Date: The celeration line will continue from the End Date to the Projection
Date as a dashed line. If you don’t want a projection line, just set Projection Date to the
same date as End Date. Timings in the domain of the dashed line are not included in the
celeration line calculation. Format: mm/dd/yy

Label Placement: There are two options:

o Default: PT Tracker will choose where to put the label that displays the celeration.

o User point: You can choose the date and y-value of the right-most edge of the
label. This can be handy if PT Tracker doesn’t choose a good default location.

Label Date: If you select “User point” for Label Placement, this is the date on which the
label will end. Format: mm/dd/yy

Label Y: If you select “User point” for Label Placement, this is the y-value at which the
label will be placed.

Which Data: There are three options:

o Count: Only display the celeration line for Count data.

o Errors: Only display the celeration line for NumErrors data.

o Count and Errors: Display the celeration lines for both Count and NumErrors
data. In this case, if you choose “User point” for Label Placement, the specified
placement will only be used for the Count celeration line. Default placement will
be used for the NumErrors celeration line.

Calc Method: There are four options. The four calculation methods are discussed in
detail in Appendix A, Celeration Line Calculation Methods. The four options are:

o Theil-Sen

Regression
Split-Middle
Quarter-Intersect

o O O

By default, the celeration line is black and the projection line is gray, but you can change these
colors using the Chart appearance option of the Settings menu.



New/Edit Aim Star Screen

You display the New Aim Star screen via the Aim Star option on the Chart menu. You display
the Edit Aim Star screen via the Edit Annotations screen.

Edit Aim Star X
Date: 10/22/2 1| Goal: 50
Direction: @ Up O Down

i)

The New/Edit Aim Star screen lets you create or modify an aim star annotation on the chart. An

aim star appears as an up or down arrow with a line through it to indicate the goal. The screen
fields are:

e Date: The date on which the aim star is displayed. Format: mm/dd/yy
e Goal: The y-value at which the horizontal line in the aim star is drawn.
e Direction: Up or Down — the direction that the arrow should point.

By default, the aim star is black, but you can change its color using the Chart appearance option
of the Settings menu.

Edit Annotations Screen

You display the Edit Annotations screen via the Edit annotations option on the Chart menu.

Edit Annotations X

Student: Samantha Roberts ID: 23
Skill: Math Facts

DayNo Type Date Description
3  |Celeration Line 9/1/21 |Date2: 10/10/21 Date3: 10/20/21 Data: Count Method: Theil-Sen Label: Defaul...
54  |Aim Star 10/22/21 |Goal: 50 Direction: Up
56 |Phase Change 10/24/21 [Y1:0.001 Y2:990 Comment: Less frequent practice

Right-click to display menu for editing or deleting an annotation. Or double-click to edit.




The Edit Annotations screen lets you view, edit, and delete existing annotations. When you
right-click on an annotation, the following menu will be displayed:

e View: View the parameters of the selected annotation.
e Edit: Edit the parameters of the selected annotation. This option will bring up the

appropriate dialog box. For example, the Edit Phase Change screen for phase change
annotations.

e Delete: Prompts you to confirm the deletion and then deletes the specified annotation.
e Exit: Exits the Edit Annotations screen.

You can also edit the parameters of an annotation by double-clicking on it.

Edit Logo Display Screen

Edit Logo Display X

Loco4Learning | ¥ Opacity: |1.000 Pick Logo

A 150x150 pixel PNG file is recommended for user logo.

Save Cancel

!

The Edit Logo Display screen allows you to change the logo that is displayed in the middle of the
chart. The screen has these user inputs:

e Logo Display Type: This option determines what logo will be displayed in the middle of
the chart on PT Tracker's main window. Options include:
o Loco4Learning: Display the Loco4Learning LLC logo.
o None: Don't display any logo.
o User: Display a user-selected logo.
e Opacity: This number from 0 to 1 controls how dark the logo will be. If the value is 0,
the logo will be invisible. If the value is 1, the logo will have the full opacity of the logo
image.

e Pick Logo: Use this button to choose the logo to be displayed if the Logo Display Type
is “User”.

Edit Nomenclature Screen

Edit Nomenclature X

Singular/NoCap Singular/Cap Plural/NoCap

Client student‘ Student students
Metric skill Skill skills
Save | Cancel

The Edit Nomenclature screen lets you change the words "student™ and "skill" to something
more appropriate for your use. The words "student” and "skill" appear repeatedly in this



documentation, in the menus, in the error messages and in the dialog boxes. You can change
those two words to something that makes more sense to you if you'd like. The Edit
Nomenclature screen has these six fields:

e Client
o Singular/NoCap: The singular form of the word that will replace "student” (not
capitalized)
o Singular/Cap: The singular form of the word that will replace "Student"
(capitalized)
o Plural/NoCap: The plural form of the word that will replace "students” (not
capitalized)
o Skill
o Singular/NoCap: The singular form of the word that will replace "skill" (not
capitalized)
Singular/Cap: The singular form of the word that will replace "Skill" (capitalized)
Plural/NoCap: The plural form of the word that will replace "skills™" (not
capitalized)

After changing the nomenclature, PT Tracker menus, dialog boxes, feedback and error messages
will use the newly specified words.

Note that whatever you specify as "Client-Singular/Cap" will appear in the title of the chart in PT
Tracker's main window. However, to replace the word "Skill:" on the chart, you need to change
the "Chart Title" field of the New/Edit Skill screen.

Chart Appearance Screen

You display the Chart Appearance screen via the Chart appearance option on the Settings
menu.

Chart Appearance X

Count: & Mark Type: ‘ Circle | V¥

Errors: Mark Type: ‘ Square | ¥

No Count:

Record Floor:

Aim Star:

Phase Change:

Projection Line: ‘ '

Celeration Line:

Save Update 1 Reset ‘ Cancel




The Chart Appearance screen lets you customize the appearance of various items on the chart.
The four buttons at the bottom of the screen have these effects:

Save: Saves any changes to the Settings file, updates the chart, and exits the Chart
Appearance screen.

Update: Saves any changes to the Settings file and updates the chart but does NOT exit
the Chart Appearance screen.

Reset: Resets all the chart appearance parameters to their default settings (shown in the
image above), saves the changes to the Settings file, and updates the chart. (You will be
prompted to confirm before any of these changes take effect.) Does NOT exit the Chart
Appearance screen.

Cancel: Cancels any changes that haven’t been written to the Settings file and exits the
Chart Appearance screen.

The items on the screen are:

Count: Click this button to change the color of the “count per time unit” marks on the
chart.

Mark Type (Count): Select the shape of the “count per time unit” marks on the chart:
circle, square, X, or dot.

Errors: Button to change color of “errors per time unit” marks.

Mark Type (Errors): For changing the shape of the “errors per time unit” marks.

No Count: Button to change the color of the question marks that represent a no-counts.
Record Floor: Button to change the color of record floor lines.

Aim Star: Button to change the color of aim stars.

Phase Change: Button to change the color of phase change lines.

Celeration Line: Button to change the color of celeration lines.

Projection Line: Button to change the color of the dashed lines that project celeration
lines into the future.



Files

Database Directory

PT Tracker saves student data in files that have the .ptt file extension in the database
directory. When you first install PT Tracker, the location of the student data files is set as
follows:

e Windows: The "Start in" directory, which is typically the directory where PT Tracker is.
e Mac OS: The user's Documents directory.

It is likely that neither of these default locations are desirable for your particular use. If that is
the case, on your first use of PT Tracker, you should use the Change/Save default database
directory option of the Settings menu to change the database directory to be its own dedicated
location.

Settings File

Usually, you will never have any need to look at the settings file. PT Tracker automatically
creates, reads, and writes it as follows:

e Onstartup, PT Tracker creates a new settings file if the file doesn't exist where it is
supposed to be. It fills the file with "factory defaults".

o If the settings file exists on startup, PT Tracker reads it and uses its contents as defaults
during the session.

« Whenever you change a setting via the Settings menu, PT Tracker rewrites the settings
file.

The location of the settings file depends on the operating system, as follows:

e Windows: The settings file is in the user's Documents directory.
e MacOS: The settings file is in the user’s Library/Preferences directory.

The name of the settings file also depends on the operating system, as follows:

e Windows: .pt-tracker.txt
e MacOS: com.loco4learning.PT-Tracker.txt

Auto-archive

Every time PT Tracker saves a student file, it also creates an archived version of it. The archived
versions are saved in a subdirectory of the database directory called archive. Every archived file
has the archive date in its name so that the last version saved on any given day will be available
on subsequent days. After three weeks, archive files are automatically deleted. There is
currently no automated way to recover archived data, but it can be done manually using the
operating system's file management commands. Here are the general steps to follow:

o If the invalid student file still exists in the database directory, rename or delete it.



o Copy the appropriate archive file to the database directory.
o Rename the copied archive file, removing the hyphen and the date after the hyphen.

For example, let's say something bad happens to the student file John_Smith_.ptt. Delete it or
rename it. Then copy an appropriate archive file to the database directory. For example, you
might want to restore the data from October 29, 2021, so you would copy the file called
John_Smith_-2021-10-29.ptt. Then rename that file to be John_Smith_.ptt.

Output Directory

The output directory is a local directory into which PT Tracker will write output files. As of
Version 5.1, the only files written there are image files. There are two ways to write image files:

e By selecting the Save chart as .png menu option of the Tools menu.
e By right-clicking on the chart and selecting Save as on the popup menu.

By default, the output directory is the same as the database directory. You can change this
location using the Change output directory option of the Settings menu.



Google Mode

Overview

To support teachers who teach their students from different computers — perhaps one at home
and one at work — PT Tracker offers the capability to automatically save student files to Google
Drive whenever they are updated on the local machine. Then, when the teacher needs to access a
file saved from a different computer, the student file can be downloaded from Google Drive
using the Download student file menu option on the Google menu.

PT Tracker's use of Google Drive is designed to protect all the other files you have placed on
Google Drive. See Data Privacy/Security and File Sharing with other Users for a description of
how PT Tracker protects your other files.

"Google mode" is disabled by default. To enable Google mode, you need to select the Change
Google Drive folder option of the Settings Menu. There, you will specify the Google folder ID
of the Google folder where you want to save your student files. After specifying the folder ID,
you must exit PT Tracker and start it again. See Configuring the Google Drive Folder 1D for
instructions on obtaining the folder ID.

Google Mode User Interface
Auto-save of Student Files

Recall that PT Tracker automatically saves a student file to the local computer every time student
data is changed. When in Google mode, whenever PT Tracker successfully saves a student file
to the local drive, it also automatically uploads a copy of the file to Google Drive. If for some
reason, PT Tracker is unable to upload a copy of the file, it will display an error message and put
the data in a queue to be uploaded later, if the problem can be fixed. NOTE: The queue is erased
when PT Tracker terminates.

Specifying Google Account and Permissions

The first time you start up PT Tracker in Google mode, Google will use your default web
browser to prompt you to:

e Specify a Google account that PT Tracker will use.
e Give PT Tracker permission to "View and manage Google Drive files and folders that
you have opened or created with this app.”

After the first use, PT Tracker and Google will typically remember your selections and it usually
won't be necessary to specify them again on subsequent uses of PT Tracker. However, if you
wish to change them, you can use the Return to Google sign-in screen option of the Google
Menu to repeat the sign-in and permissioning sequence.



Google Menu

In addition to automatic uploads to Google Drive, the following options are available on the
Google menu when in Google mode:

Download student file: Displays a list of all the student files in the Google Drive
Folder. You will have the option of downloading one of those student files. If there is a
file by the same name in the currently active database directory of the local computer, the
downloaded file will replace it. After the file is downloaded to the local computer, the
downloaded student data will be displayed.

Upload student file: Displays all the student files in the currently selected local database
directory. You will have the option of uploading one of those files to the Google Drive
Folder. As with automatic uploads, if an error occurs while uploading the file, an error
message will be displayed and the data will be placed in a queue for later uploading if the
problem can be fixed.

Return to Google sign-in screen: Allows you to re-specify the Google account you want
PT Tracker to use. In your default browser, Google will also ask you again whether you
want to give PT Tracker permission to save and read Google Drive files (as described
above in the section Specifying Google Account and Permissions).

Cancel attempt to sign-in to Google: Usually, when PT Tracker accesses Google Drive,
the operations are relatively quick. However, the sign-in process depends on user input,
and so it can take a long time, or the user can make a mistake and cause PT Tracker to
wait forever for a user response. When this happens, you can use the Cancel attempt to
sign-in to Google menu option to terminate the sign-in process.

Disable/Enable Google interface: This menu item disables Google functions. When the
Google interface is disabled:

o Youwon't be able to use other Google menu items until you re-enable the Google
interface.

o Any time PT Tracker automatically saves a file to the local computer, it will add
the data to the queue for later uploading to Google. Again, remember that the
queue gets erased when PT Tracker terminates, so if there is anything in the queue
on termination, it will not have been saved to Google Drive.

Google Status Display

In Google mode, the status of the Google interface is always displayed in the lower right-hand
corner of PT Tracker. The status consists of a filled in circle whose color indicates the current

status.

Possibilities include:

Green: PT Tracker successfully connected to Google. Student file uploads (both
automatic and requested) and downloads should succeed.
Yellow: Google sign-in is in progress. You need to respond to the Google authorization
request in your default browser.
Orange: A Google Drive operation (other than sign-in) is in progress. These operations
usually finish quickly unless there is an internet glitch. These operations include:

o Uploading a student file

o Downloading a student file

o Verifying that the Google Drive Folder is valid for saving files. This operation is

performed automatically at start-up, after signing in again, and whenever a new



Google Drive Folder ID is specified (via the Change Google Drive folder menu
option of the Settings menu).

o Red: PT Tracker did not successfully connect to Google. No file uploads or downloads
can be performed. Auto-saves to Google Drive will be queued. You will need to use the
Return to Google sign-in screen option on the Google Menu to make the status turn
green.

o Gray: Google interface disabled. Auto-saves to Google Drive will be queued. You will
need to re-enable the interface via the Enable Google interface menu option in order to
resume uploading and downloading student files.

PT Tracker v4.0 . O X
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Save Queue

In Google mode, if for some reason PT Tracker is unable to upload a student file to Google
Drive when required, a copy of the file is added to an internal "save queue™ so that it can be
uploaded as soon as possible. PT Tracker attempts to upload the data in the save queue
whenever any Google Drive operation is successfully completed. This means that the queued
student data will be uploaded after a successful sign-in to Google on behalf of PT Tracker.

Whenever there are items in the save queue, an ugly yellow button will be displayed in the lower
right-hand corner of PT Tracker. This ugly button serves as a warning that data has not been



uploaded. If you click on the button, a list of the queued student files will be displayed. When
this list is displayed, if PT Tracker believes that it might be possible to successfully upload the
files, it will also offer an option to attempt an upload of the queued data.

The save queue is lost when PT Tracker terminates, so any student files that are in the queue
when PT Tracker terminates will not get uploaded to Google Drive.

Configuring the Google Drive Folder ID

Every Google Drive file and folder has a unique 1D that never changes throughout the life of the
folder or file. You can rename the file, move it to another folder, or delete it; it will still have the
same ID until it completely disappears from Google’s system. To use PT Tracker’s Google
mode, you need to obtain the unique folder ID of the Google Drive folder where you want to put
your student files.

To get the folder 1D and enable Google mode in PT Tracker, perform the following steps:

o Create a Google Drive folder to hold the PT Tracker files.
o Obtain the Google Drive file ID of the folder. You can do this as follows:
Sign in to Google Drive.
Find the folder you created for PT Tracker files.
Right-click on the folder name to display a Google menu.
Select the Get Link menu item.
Google will display a link that looks something like this:
= https://drive.google.com/drive/folders/1DQ3zj9axvaofswlZAeMLzym5X
RLxkGaC?usp=sharing
o Thefile ID is everything between the last forward slash and the question mark.
= In this example, it would be:
1DQ3zj9axvaofswlZAeMLzym5XRLxkGaC
o Copy the file ID of the folder (but not all the other stuff in the link).
o Start PT Tracker
o Go to the Settings menu and choose Change Google Drive folder.
o Inthe dialog box, paste in the file ID.
o Exit PT Tracker and restart.

O O O O O

Data Privacy/Security and File Sharing with other Users
PT Tracker uses a special Google Drive access permission that ensures the safety and privacy of
all the user's other Google Drive files. Before PT Tracker can access your files on Google Drive,
Google opens a tab in your default browser and asks you:
1) What Google account do you want to use for PT Tracker’s access to Google Drive, and
2) Do you want to give PT Tracker permission to "View and manage Google Drive files
and folders that you have opened or created with this app."
Here are some things to know about this mode for accessing Google Drive:

e By using this mode, PT Tracker will not be able to access files that it didn't create.



o There is one exception: PT Tracker will be able to create, modify and delete its
own .ptt files in the Google Drive folder you specify using the procedure in
section Configuring the Google Drive Folder ID.

o PT Tracker can only read or overwrite files created while signed in to Google with the
same account that created those files. PT Tracker won't even be able to see/read files
created via another Google account, even if they are in the same directory and even if
they were created by PT Tracker.

e PT Tracker can access a shared Google Drive folder if the specified Google account has
Editor privileges on the folder. However, again, if different Google accounts put files
into a shared folder, PT Tracker will only be able to see/read the files created under the
same account that wrote them.

A user of PT Tracker can be confident that the program will not be able to read or write any
Google Drive files but its own and the folder you specify. This restriction is enforced by
Google, not by PT Tracker.

Sharing Google Drive Student Files with other Users

All the privacy restrictions can make it problematic to share student files with another Google
Drive user. If other people need to use PT Tracker to access the same student files on Google
Drive, everyone needs to use the same Google login. In that case, | suggest that you create a new
Google account specifically for when people use PT Tracker. They would then sign in to that
account when PT Tracker starts up and Google asks for your permission to let PT Tracker access
Google Drive.

Alternative to Google Mode

The purpose behind Google Mode is to write student files to the cloud so that they can be
accessed from anywhere. There are probably other ways to accomplish this, although I haven’t
personally tested them.

There is software available that can make cloud files and folders appear as if they are on the local
computer. | believe Dropbox and Google both offer software to do this. You would then set the
Database Directory to be a cloud-based folder established by one of these vendors.

One disadvantage of this type of solution is that if you lose your internet connection, you will
also lose your ability to look at and update the student data. (Some vendors may also have a
solution for that too, by maintaining both local and cloud versions of the files.)



Appendix A

Celeration Line Calculation Methods
PT Tracker offers four different algorithms for calculating celeration lines. They are:

Theil-Sen

OLS regression
Split-middle
Quiarter-intersect

According to Koenig (1972), Koenig and Ogden Lindsley developed the quarter-intersect
method. It is also documented in Pennypacker, Gutierrez, and Lindsley (2003). | believe the
intention was to create a deterministic algorithm that could be easily performed so that precision
teaching practitioners could confidently create celeration lines without needing to do numerous
arithmetic calculations. In my opinion, computers have made this method obsolete, but | have
still included it in PT Tracker because of its traditional association with precision teaching.

| don’t have the original split-middle paper by O. R. White, 1974, The split middle: A quickie
method of trend estimation, but White and Haring (1980) describes the method. Another
description can be found in Datchuk and Kubina (2011). The split-middle algorithm retains the
advantage of not requiring arithmetic calculations and fixes some of quarter-intersect’s problems.
However, it still has some deficiencies.

OLS regression is a common approach across many fields for estimating the relation between
two variables and is quite readily calculated by computers. Some precision teaching
practitioners have criticized it because it assigns a relatively large weight to outliers.

Theil-Sen, suggested to me by Stuart Harder and described in Sen (1968), is another approach
for estimating the linear relation between two variables and is also quite readily calculated by
computers. To my knowledge, it is not traditionally used by most precision teaching
practitioners, but since it doesn’t overweight outliers, it appears to answer the concerns they have
with OLS regression. For that reason, it is the default calculation method in PT Tracker.

Note: All celeration line calculations are performed in log space. That, of course, presents a
problem when either the count or the number of errors is zero because 10910(0.0) is undefined.
Omitting such observations from the calculation cannot be correct because they provide very
important information about the learner’s progress. There is no good solution, but PT Tracker
resolves the problem by dividing the record floor by two and taking the log10 of the result. In
other words:

Yinput to caleulation = 10910(0.5 / duration)

The following sections document the four methods.



Theil-Sen

You can find more about Theil-Sen on Wikipedia and here is another link with useful
information:

https://blogs.sas.com/content/iml1/2019/05/28/theil-sen-robust-regression.html

The Theil-Sen algorithm works like this:

1. Find the slope between every pair of observations, except that no slopes are calculated
between observations that are on the same day as each other.

2. The median slope of all the slopes calculated in Step #1 defines the celeration. (If there
are an even number of slopes, the average of the two middle slopes defines the
celeration.)

3. The y-intercept is calculated by using the median slope (from step #2). Using that slope,
a line is projected back to the y-axis for every observation (obviously, these will all be
parallel lines). The median of these y-intercepts is the y-intercept of the celeration line.
(If there are an even number of observations, the y-intercept of the celeration line is the
average of the two middle y-intercepts.)

Because of step #3, there will be an equal number of observations above the celeration line as
below it. (In some cases it is impossible to equalize them, but, in all cases, the number of
observations on either side of the celeration line will be equalized to the maximum extent
possible for the calculated slope.)

OLS Regression

In PT Tracker, ordinary least squares regression generates the same line as is obtained by asking
Microsoft Excel to put a linear trend line on a scatter chart.

Split-Middle
The split-middle celeration line is calculated as follows:

1. The observations are divided into two sets of points, each with the same number of
points. The first set has all the points closest to the start date and the second set has all
the points closest to the end date.

a. If there is an odd number of observations, the middle observation is NOT put into
either set.

2. In each set, the median date is determined.

3. In each set, the median y-value is determined.

4. Putting each set’s median date and median y-value together forms a kind of “median
point” for each set.

5. The celeration is defined by the slope of the line that passes through the two “median
points”.

6. The intercept is determined by using the slope from step #5 and finding the celeration
line that results in an equal number of points being above the line as below it. (PT
Tracker does this by using the method described above in Step #3 of Theil-Sen.)


https://blogs.sas.com/content/iml/2019/05/28/theil-sen-robust-regression.html

The split-middle algorithm has these deficiencies:

I couldn’t find a published description of what to do when there are multiple observations
on one date (although such a publication might exist). For that reason, | implemented my
own solution, which was:
o Instep # 1, for all points on a given date, find the median y-value and treat that
date as if it had just one point when calculating the celeration.
o Instep #6, treat all observations separately, even if some fall on the same dates as
others.
If there is an odd number of dates, the middle date is ignored when calculating the
celeration. It is not good to ignore data! In split-middle, that ignored point has no impact
on the celeration calculation, but in Theil-Sen and OLS regression, the middle point can
definitely impact the celeration calculation.
I couldn’t find a published description of whether to include any ignored middle point in
step #6 of the split-middle algorithm. [ included it.

Some might argue with the choices I made, and that’s fine. If the precision teaching community
reaches a consensus on how to handle these situations, I'll implement the consensus method.
However, I don’t think it’s worth the time to try to reach that consensus, as | believe that either
OLS regression or Theil-Sen are superior in any case.

Quarter-Intersect

The quarter-intersect celeration line is calculated as follows:

1.
2.

3.

A starting date and ending date are determined.
The distance between the starting and ending date is divided in two halves of the same
amount of calendar time.
If an observation falls exactly between the starting and ending dates, it is ignored.
In each of the halves:

a. The median y-value is determined using all the observations that fell within that

half.

b. An x-value is calculated as the exact calendar time middle of that half.
In each half, the calculated x-value and median y-value are combined to form a kind of
“median point”.
The celeration is defined by the slope of the line that passes through the two points.
The y-intersect is the y-value where the line from Step #6 passes through the y-axis.

The quarter-intersect method has all the disadvantages of the split-middle method, plus these:

Changing the starting and/or ending date typically changes the celeration value even
though all the observations are the same as before.

There can be a disproportionate number of observations on one side of the celeration line.
The two halves created in Step #2 can have a different number of observations than one
another. This can result in just a few points having oversized weight in the calculation of
the celeration line.



PT Tracker has two diagnostic screens for verifying the results of the celeration line calculations.
To use these screens, select the Celeration line diagnostics menu option on the Tools menu.
This brings us a list of all valid celeration lines on the current chart. Choose a celeration line to
display the Celeration Line Diagnostics screen. If the chart only has one valid celeration line
annotation, you won’t be offered a choice; the diagnostics for that celeration line annotation will

Celeration Line Diagnostics

Appendix B

be displayed as soon as the Celeration line diagnostics menu option is selected.

The other diagnostic screen is the Theil-Sen Diagnostics screen. You display it by clicking the
View Slopes button on the Celeration Line Diagnostics screen when it is showing diagnostics for

a Theil-Sen celeration line.

Celeration Line Diagnostics Screen

Celeration Line Diagnostics

Which data: ® Count O Errors

Calculation Method:  Theil-Sen

Start/End Dates: 9/1/21  10/10/21 Observations: 18

Middle Dates: n/a n/a

Y-Int/Log10(Y-Int): 22193 1.346

Celeration/Slope: x1.13  0.0075 Slopes calculated: 152 View Slopes

Y<CL/Y=CL/Y>CL: 9,0,9

DayNo Date Duration Count NumErrors Y-Value | Log10(y) | Raw Intc | Cel Line Diff

0 9/1/21 1.0 20 3 20.00 1.301 1.301 1.346 -0.045
0 9/1/21 1.0 22 - 22.00 1.342 1.342 1.346 -0.004
2 9/3/21 1.0 20 3 20.00 1.301 1.286 1.361 -0.060
5 9/6/21 1.0 23 - 23.00 1.362 1.324 1.384 -0.022
7 9/8/21 0.5 13 2 26.00 1.415 1.363 1.398 0.017
9 9/10/21 0.5 14 2 28.00 1.447 1.380 1.413 0.034
12 9/13/21 0.5 14 1 28.00 1.447 1.358 1.436 0.011
14 9/15/21 0.5 15 1 30.00 1.477 1.373 1.451 0.026
16 9/17/21 0.5 17 0 34.00 1.531 1.412 1.466 0.066
19 9/20/21 0.5 16 1 32.00 1.505 1.363 1.488 0.017
21 9/22/21 0.5 17 0 34.00 1.531 1.375 1.503 0.029
23 9/24/21 0.5 20 1 40.00 1.602 1.430 1.518 0.084
26 9/27/21 1.0 35 3 35.00 1.544 1.350 1.540 0.004
28 9/29/21 1.0 35 2 35.00 1.544 1.335 1.555 -0.011
30 10/1/21 1.0 35 0 35.00 1.544 1.320 1.570 -0.026
33 10/4/21 1.0 36 2 36.00 1.556 1.310 1.593 -0.036
35 10/6/21 1.0 40 2 40.00 1.602 1.341 1.607 -0.005
37 10/8/21 1.0 40 1 40.00 1.602 1.326 1.622 -0.020




The contents of the Celeration Line Diagnostics screen depend on which calculation method was
used. The following fields appear for all calculation methods:

Which data: This box indicates whether the data is for the count celeration line or the
errors celeration line. If both were calculated, you can click on one to display its
diagnostic information.

Calculation Method: Theil-Sen, Regression, Split-Middle or Quarter-Intersect.
Start/End Dates: The start and end dates that define which observations were used to
calculate the celeration line.

Observations: The number of observations within the specified dates.

o For split-middle and quarter-intersect, a second number is displayed. It is the
number of observations that were used in the celeration calculation. For example,
this value would not include the middle date. Also, if one or more dates had
multiple observations, each such date would only be counted once in this value.

o The Theil-Sen and OLS regression methods do not show that second value
because they operate on all observations directly.

Middle Dates:

o Theil-Sen: not applicable

o Regression: not applicable

o Split-middle and quarter-intersect: Two values:

= First value: Last date in the first set of observations
= Second value: First date in the second set of observations
Y-Int/Logl0(Y-Int): Two values:
o First value: The y-intercept in counts per time unit or errors per time unit.
o Second value: Log10 of the first value.
Celeration/Slope: Two values:
o First value: The celeration
o Second value: The slope in log space
Y<CL /Y=CL /Y>CL: Three values. The sum of the three numbers should be equal to
the number of observations.

o First value: Number of observations that are below the celeration line

o Second value: Number of observations that are on the celeration line

o Third value: Number of observations that are above the celeration line

Theil-Sen: On the Celeration Line Diagnostics screen for Theil-Sen, you will see these two

fields:

Slopes Calculated: The number of slopes calculated in order to find the median slope.
View Slopes (button): Click this button to bring up the Theil-Sen Diagnostics screen.

Split-middle and quarter-intersect: On the Celeration Line Diagnostics screen for split-middle
and quarter-intersect, you will see these two fields:

Half median offsets: Two values, one for each of the two sets of observations. These are
the day offsets (from day 0) for the two points that are used to calculate the celeration.
o Split-middle: The two values represent offsets to the day numbers of the median
observation dates within each set.



o Quarter-intersect: The two values are offsets to the x-values that are 25% and
75% of the distance from the starting date to the ending date. They will add up to
one less than the total number of calendar days in the date range of the celeration
line.

Median Y (halfl/half2): Four values: The first two are log10 of the median y-values
calculated for each set. The second two are the actual median y-values.

Split-middle: On the Celeration Line Diagnostics screen for split-middle, you also will see these
two fields:

Pre-adjust y-intercept: Two values, each representing the y-intercept of the initial
celeration line calculation (before finding the y-intercept that equalizes the number of
observations on each side of the celeration line):

o First value: Logl10 of the pre-adjustment y-intercept

o Second value: Pre-adjustment y-value
Pre-adjust balance: This value is calculated using the pre-adjust y-intercept. It is the
difference between the number of observations that are above the celeration line and the
number of observations that are below the celeration line. If it is zero, PT Tracker did not
need to adjust the y-intercept.

Regression: There are no additional diagnostic fields when the OLS regression method is used
to calculate the celeration line.

The table on the Celeration Line Diagnostics screen has one row for each observation within the
domain of the celeration line. The table has these columns:

DayNo: Day offset from the start date of the celeration line. The start date is day 0.
Date: Date of the observation.

Duration: Duration of the observation.

Count: Count of the observation.

NumErrors: Number of errors observed.

Y-Value: The y-value that appears on the chart. It is either count per time unit or number
of errors per time unit, depending on which set of data is being displayed.

Log10(y): Logl10 of Y-Value. If Y-Value is zero, this column will have
log10(0.5/duration), which is the input to the celeration line calculation.

Eighth column: The column header of the eighth column depends on which calculation
method was used:

o Raw Intc: The y-intercept calculated using the calculated Theil-Sen slope and the
y-value for this observation. (The median of all values in this column will be the
y-intercept of the celeration line.)

o Input: The y-value that is used as input to the celeration calculation for split-
middle and quarter-intersect.

= For dates with more than one observation, the first such date will show the
median observation for all such dates. The field will be blank in the other
rows.
= |fadate was ignored in the celeration calculation because it fell exactly in
the middle of the two sets of observations, this field will say, “Mid”.
o Unused: This column is empty for OLS regression.
Cel Line: Log10 of the celeration line value for the date of that observation.



= Diff: The difference between Log10(y) and Cel Line. If the two values are equal, two
dashes (“--") will be displayed. Sometimes the difference between the two values will be
so small that the value will appear as either 0.000 or -0.000, which means that the
difference was very small, but still either positive or negative.

Theil-Sen Diagnostics

You can display the Theil-Sen Diagnostics screen by clicking on the View Slopes button of the
Celeration Line Diagnostics screen. The screen consists of a table with one row for each slope
calculated in the Theil-Sen celeration calculation. The rows are sorted by slope, lowest to
highest. The columns are as follows:

= #: Row number.

= Dayl: Day number of the first point used in the slope calculation.

* Y1: Logl0 of the y-value of the first point used in the slope calculation.

= Day2: Day number of the second point used in the slope calculation.

= Y2:Logl0 of the y-value of the second point used in the slope calculation.

= Slope: The slope calculated using the two points (Dayl, Y1) and (Day2, Y2).

The Theil-Sen slope will be the middle slope in this list or will be the average of the two middle
slopes if the number of slopes is even.
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